
 

USER’S GUIDE

 

AudioGate Ver. 2.0



 

 

 

Contents

 

Introduction  . . . . . . . . . . . . . . . . . 3

Supported formats  . . . . . . . . . . . 3

 

Supported file formats  . . . . . . . . . . . . . . . . . . . 3

Supported disc formats  . . . . . . . . . . . . . . . . . . 4

 

Items on the screen . . . . . . . . . . . 5

 

About the level meter and clip indicator . . . . . . 5

 

Importing to a songlist  . . . . . . . . 7

 

Importing an audio file  . . . . . . . . . . . . . . . . . . . 7

Importing an MR project . . . . . . . . . . . . . . . . . . 8

Importing an audio CD/DSD disc . . . . . . . . . . . 9

 

Song Playback . . . . . . . . . . . . . . 10

 

Playing back a song . . . . . . . . . . . . . . . . . . . . 10

Contents of the info viewer display  . . . . . . . . 10

Transport Controllers . . . . . . . . . . . . . . . . . . . 11

Playback mode setting . . . . . . . . . . . . . . . . . . 12

Repeat playback  . . . . . . . . . . . . . . . . . . . . . . 12

Direct Locate function  . . . . . . . . . . . . . . . . . . 12

Direct song selection  . . . . . . . . . . . . . . . . . . . 13

Audio device settings . . . . . . . . . . . . . . . . . . . 13

 

Song editing . . . . . . . . . . . . . . . . 14

 

Basic operation in the songlist . . . . . . . . . . . . 14

Saving a songlist  . . . . . . . . . . . . . . . . . . . . . . 14

Opening a songlist . . . . . . . . . . . . . . . . . . . . . 14

Opening a recently-used songlist . . . . . . . . . . 14

Renaming a song . . . . . . . . . . . . . . . . . . . . . . 14

Editing text data . . . . . . . . . . . . . . . . . . . . . . . 15

Changing the attached picture . . . . . . . . . . . . 16

Editing metadata for multiple songs . . . . . . . . 17

Editing the song settings  . . . . . . . . . . . . . . . . 18

Dividing a song  . . . . . . . . . . . . . . . . . . . . . . . 19

Combining songs . . . . . . . . . . . . . . . . . . . . . . 19

Channel Link function  . . . . . . . . . . . . . . . . . . 20

Mark function . . . . . . . . . . . . . . . . . . . . . . . . . 20

Viewing file information  . . . . . . . . . . . . . . . . . 22

Other convenient functions  . . . . . . . . . . . . . . 22

 

Exporting in 
a different audio format . . . . . 23

 

Exporting an audio file . . . . . . . . . . . . . . . . . . .23

Creating an audio CD or DSD disc  . . . . . . . . .27

Optional settings  . . . . . . . . . . . . . . . . . . . . . . .29

 

Other settings . . . . . . . . . . . . . . . 32

 

Changing the folder 
where temporary files are created  . . . . . . .32

Resetting the warnings of all dialog boxes  . . .33

 

List of shortcuts . . . . . . . . . . . . . 34



                                                       
Introduction
AudioGate is an audio file conversion application that supports 1-bit audio. Using AudioGate, audio files
recorded by the Korg MR series can be converted and exported in the desired format, and you can create audio
CDs or DSD discs. Editing operations such as cut, fade, and normalize are also supported.

Supported formats

Supported file formats
AudioGate is able to import/export (input/output) audio files of the following formats.

*1 Supported if QuickTime7 is installed

*2 Supported if Flip4Mac WMV is installed.
http://www.microsoft.com/windows/windowsmedia/player/wmcomponents.mspx

*3 Supported if Windows Media Player 10 or later is installed

In some cases, it may not be possible to correctly read files that were not created by a Korg MR series unit or
by AudioGate.

Audio files protected by DRM (Digital Rights Management) cannot be loaded.

File format
(extension)

Windows Mac Number of 
channels

Sample rate Bit depth

In Out In Out

PCM WAV (.wav) ● ● ● ●

1ch

2ch

44.1 kHz, 48 kHz

88.2 kHz, 96 kHz

176.4 kHz, 192 kHz

16 bit, 24 bit

32 bit(float)*1BWF (.wav) ● ● ● ●

AIFF (.aif/.aiff) ● ● ● ● 16 bit, 24 bit

1-bit DSDIFF(.dff) ● ● ● ●

1ch

2ch

2.8224 MHz

5.6448 MHz 1-bitDSF(.dsf) ● ● ● ●

WSD(.wsd) ● ● ● ●

Irreversible 
compression

MP3 (.mp3) ● ❍*3 ❍*1

1ch

2ch

44.1 kHz, 48 kHz -

AAC (.m4a) ❍*1 ❍*1 ❍*1

WMA (.wma) ● ● ❍

*1, *2

WMA Profes-
sional (.wma)

● ● ❍

*1, *2

2ch 44.1 kHz, 48 kHz

88.2 kHz, 96 kHz

Lossless 
compression

WMA Lossless 
(.wma)

● ● ❍

*1, *2

2ch 44.1 kHz, 48 kHz

88.2 kHz, 96 kHz

16 bit (only 44.1 
kHz), 24 bit

Apple Lossless 
[ALAC] (.m4a)

❍*1 ❍*1 ❍*1 1ch

2ch

44.1 kHz, 48 kHz

88.2 kHz, 96 kHz

176.4 kHz, 192 kHz

16 bit, 24 bit

FLAC (.flac) ● ● ● ●
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Supported disc formats
AudioGate supports reading and creation of audio CDs and DSD discs.
AudioGate can create discs in the following formats.

 Writing to dual-layer DVD media is not supported.

 A writable CD/DVD drive is required in order to create audio CDs or DSD discs.

 What are DSD discs?
DSD discs are a new disc format that was created as a way for an individual to record and playback DSD for-
mat material. This means that the methods used to create audio discs on CD-R or CD-RW media are now also
available for the world of DSD audio. DSD discs can be played on compatible players and enjoyed in their
original high quality.

DSD disc is a disc format that is different than the Super Audio CD. Not all Super Audio CD players will
necessarily be able to play back a DSD disc.

* DSD discs (1-bit; 2.8 MHz) created by AudioGate Version2.0 can be played back on players such as the
Sony SCD-XA5400ES Super Audio CD/CD player or PLAYSTATION®3 from Sony Computer Entertain-
ment Inc. DSD discs to be played on the Sony SCD-XA5400ES require the following conditions. AudioGate
Version 2.0 meets this conditions. (As of April 1st, 2009, confirmed by KORG Inc.)

- Disc: DVD-R, DVD-RW, DVD+R, and DVD-RW, that are compatible with DVD-ROM specifications

- File extension: dsf

- Folder type: DSD_DISC folder

- Maximum size of a file: up to 4GB

- Channel: 2-channel

- Maximum number of playable files: up to 150 files per folder

Disc format Audio CD (CD-DA) DSD discs

Disc media CD-R, CD-RW DVD-R, DVD-RW

DVD+R, DVD+RW

Approximate recording time Approx. 74 minutes 
(when using 700 MB media)

Approx. 100 minutes 
(when using 4.7 GB media)

Number of albums 
that can be recorded on one disc

1 1

Maximum number of tracks 
that can be recorded on one disc

99 99

Recording time for one track Minimum 4 seconds 0 seconds

Maximum Approx. 74 minutes Approx. 100 minutes (4 GB)

Sampling frequency 44.1 kHz 2.8224 MHz

Bit depth 16 1

Number of channels 2 2

Recordable metadata CD-TEXT format 
(alphanumeric only)

• Title

• Artist name

* Not recordable for some drives

ID3v2.3 format

• Title

• Artist name

• Genre

• Date and time of recording

• Attached picture
4



     
- Maximum number of playable folders: up to 200 folders per disc

- Maximum number of playable layers: up to 8th layer

- Sampling frequency: 2.8224 MHz

* PLAYSTATION is a registered trademark of Sony Computer Entertainment Inc.

Japan: http://www.jp.playstation.com/

US: http://www.us.playstation.com/

Europe: http://uk.playstation.com/country-selector/

Please check following URL for other countries.

http://www.playstation.com/country-selector/

* “DSD Disc Format” is a trademark of Sony Corporation.

Items on the screen

About the level meter and clip indicator
During song playback and during export, AudioGate's level meter shows the peak values of the output data fol-
lowing sample rate conversion.
When playing a song, exporting a PCM file, or creating an audio CD, the units are dBFS relative to full-scale lin-
ear PCM data (0 dB).

 Except for when exporting a 32-bit (float) file, the clip indicator will light when there is a signal that would
exceed 0 dBFS, and the signal will be clipped to 0 dBFS and exported.

When exporting a 1-bit audio file and when creating a DSD disc, the units are dB-SACD, with the theoretical
limit of Delta-Sigma conversion defined as +6dB-SACD.

Normally, you will adjust the GAIN (see page 18)so that the peak value of the 1-bit output data stays within
the 0–+3 dB-SACD range.

It is not necessarily the case that the output signal has clipped at the point that 0 dB-SACD or +3 dB-SACD is
exceeded; however when the integrator of the Delta-Sigma modulator reaches a specific amount, the clip
indicator will light and the signal will be output in a clipped state.

Controllers

Songlist

Menu

Info 
viewer

Level
meter

Clip
Indicator

[EXPORT] button

[BURN DISC] button
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The conversion algorithm of most PCM <-> DSD converters (including AudioGate) is designed so that by
default, 0 dBFS = 0 dB-SACD.

Changing the peak hold time
AudioGate's level meter and clip indicator provide a peak hold function. Here's how to change the length of time
that these indications are held.

1. Right-click (Mac: Control+click) the level meter.

2. Choose “Peak Hold Duration of Level meter >” or “Hold Duration of Clip Indicator >” and select the
desired time from the options shown.

Clearing the peak hold indication
When the level meter is in use, clicking the level meter will clear the hold indicators without waiting for the spec-
ified hold times.
6



      
Importing to a songlist
Audio files, MR projects, or audio CD/DSD discs can be imported into an AudioGate songlist and played within
AudioGate or converted to a desired format for export.
In AudioGate, each item of audio data in the songlist is called a “song.”

Simply importing an item into an AudioGate songlist does not back up the file. Before you proceed, we rec-
ommend that projects recorded on your MR series unit be copied to the hard disk of your computer.

Importing an audio file
• Drag the audio file that you want to import into the songlist.

Alternatively, you can click the [ADD] button and select the desired audio file from the file selection dialog
box.

drag & drop
[ADD] button
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Importing an MR project
You can import a project that was recorded on a Korg MR series unit.
Although it is possible for data recorded on your MR series unit to be imported as an audio file, importing the
data as an MR project will allow the marks that were added during recording to be imported, and even if the
audio files have been divided they will automatically be joined so that they can be handled as a single song.

• Drag the MR project (the entire MR project folder) that you want to import into the songlist.
Alternatively, you can click the [ADD] button and select the .prj file (located in the folder) from the file selec-
tion dialog box.

drag & drop
[ADD] button
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Importing an audio CD/DSD disc
The tracks from an audio CD/DSD disc can be imported as songs.

You cannot load a DSD disc using a drive that does not support DVD.

1. Insert the disc into your computer's CD/DVD drive.
If another window (a different application) appears, close that window.

2. Choose the [File]-[Open Disc...] command.
A list of the audio discs inserted in your computer's drives will appear.

If your computer does not detect a disc, a message will indicate “No audio discs found.” Wait for a brief
time, and if the disc is still not detected, check whether the drive is correctly connected to your computer
and make sure that there is no problem with the disc that has been inserted.

3. From the list of audio discs, select the disc that you want to import, and click the “OK” button.

If the audio CD you're importing contains embedded CD-TEXT data, the track titles will be used as the song
names.
9



       
Song Playback
AudioGate will play back songs that are imported into the songlist. This provides a useful way to check the con-
tent of a 1-bit audio file, or to specify editing points.

The song playback functionality provided by AudioGate is a convenience feature that uses a high-speed fil-
ter. In order to experience the full sound quality of 1-bit audio, please use a device that supports 1-bit audio,
such as the Korg MR series.

In AudioGate, the song that's playing (or paused for playback) is called the “current song.” The current song
is indicated by a speaker icon in the songlist, and the info viewer will display information about that song.
The current location in the current song is called the “current position”. The current position can be seen in
the time display.

Playing back a song
Double-click a song in the songlist to make it the current song. Playback will begin automatically.

If you experience problems with playback, for example if there is no sound or if there are frequent clicks or
pops in the playback, please refer to "Audio device settings" (page 13).

Contents of the info viewer display
The info viewer shows information about the current song. 

Speaker icon Double-click the song 
you want to play

[MARK] button

Format

Sample rate of 
the audio device

Song name

Text information

Time information
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Transport Controllers
You can use the following features to control the playback. 

 Item Method

Sample rate of the audio device Indicates the sample rate of the audio device. The current song is converted to 
this sample rate in realtime as it plays.

Song name Indicates the name of the current song.

Text data Indicates the title and artist name of the current song.

Format Indicates the file format, number of channels, sample rate, and bit depth of 
the current song. When playing files with irreversible compression, the “bit 
depth” icon will be the “bit rate” indication (e.g., 128 kbps).

[MARK] button Click the [MARK] button, and the mark editing window will open.

Time information Indicates the playback time and the current playback location of the current song.

Controller name Action

[Play/Pause] button Switches the current song between playback and pause

[Stop] button Stops playback of the current song.

[FF] button Changes the current position to the next mark location. If there is no next mark, the
current position will change to the next song in the songlist. By holding down this
button you can fast-forward the playback point.

[REW] button Changes the current position to the previous mark location. If there is no previous
mark, you will move to the beginning of the song. By holding down this button you
can rewind the playback point.

[To] button If you click this while paused, a two-second region ending at the current position
will play.

[From] button If you click this while paused, a two-second region starting from the current position
will play.

Time wheel You can drag this upward/downward to make fine adjustments to the current position.

Time slider This graphically indicates the current position. You can change the playback point by
dragging this to left or right.

REW FF

Stop

To From

Play

Time wheel

Time slider
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Playback mode setting
The playback mode will change each time you click this.

SINGLE
Only the current song will play.
When the song finishes playing, playback will return to the beginning of the current song, and then stop.

ALL
The current song and all subsequent songs will play consecutively.
When the last song finishes playing, playback will return to the first song of the songlist, and then stop.

SHUFFLE
All songs in the songlist will play in shuffled order.
When all songs have finished playing, playback will stop.

Repeat playback
Repeat playback will turn on/off each time you click this.

(on)
Repeat playback will be used. This setting is valid for all playback modes.

(off)
Repeat playback will not be used. Playback will stop when the song(s) have finished playing.

Direct Locate function
This allows you to specify the current position directly from the keyboard.

1. While a song is playing or stopped, click the counter in the info view.

2. The counter will become an editable field. From the keyboard, enter the new counter position (e.g., 2:30).
You may omit the colon (:), and simply enter “230” (interpreted as “2:30”) or “1204” (interpreted as “12:04”).

Note that the current position has changed.

Click
Keyboard input
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Direct song selection
This allows you to specify the current song directly from the keyboard.

1. While the song is playing or stopped, enter a new songlist number such as “12” from the keyboard and
press the Enter key to finalize the change.

2. The current song will switch to the one you specified, and playback will start automatically.

If you enter a number that is greater than the number of songs in the songlist, the last song will be selected.

Audio device settings
From the menu, choose [Edit]-[Preferences...] (Mac: [AudioGate]-[Preferences...]) to access the audio device set-
tings. If the song does not play correctly, please check these settings to make sure that each item is configured
properly.

Fast CPU is required for stable playback of 1-bit audio files. If there are frequent clicks or pops in the play-
back, you may improve the performance by setting the audio sample rate lower and/or by setting the audio
buffer size larger.

Click
13



              
Song editing
AudioGate lets you divide or combine songs in the songlist. This allows you to export selected regions from an
audio file, or combine multiple consecutively-recorded files into a single file before you export it. You can also
edit the gain, fade, and DC cut settings of each song, and edit text data such as the title and artist name.

Basic operation in the songlist

Saving a songlist
From the menu, choose [File]-[Save Songlist As...] and specify a file name and a save-location. Songlist files will
have an extension of “.agsl”.

Opening a songlist
From the menu, choose [File]-[Open Songlist...] and specify a songlist file that you saved.

If the current songlist has not yet been saved, a message of “Save the current songlist before opening?” will
appear. Choose [Save] if you want to save the current songlist, or [Don't Save] if you don't want to save it.

If an audio file cannot be found because it has been moved or deleted, the song name is displayed in red. You
can't play or export a song that is displayed in red.

Even if AudioGate is not running, you can automatically start up AudioGate and load a songlist by drag-
and-dropping the desired songlist file (.agsl) onto the AudioGate icon.

Opening a recently-used songlist
1. From the [File] menu, choose [Open Recent Songlist >].

A submenu will open, showing [Open Last Songlist] and a list of the recently used songlists.

2. Choose the songlist that you want to open.

 Even if you did not save the songlist before exiting AudioGate, you can use [Open Last Songlist] to recover
the songlist.

The date and time shown in the songlist are the date and time at which it was last saved.

Renaming a song
When you click the song name in the songlist (or double-click the song name in the info viewer), the text will
become editable. After you've finished editing the name, use the Enter key to finalize the change.

The song name is used as the name of the output file when exporting.

You can't rename a song using the same name as another song in the list.

Operation Method

Select a song Click the song. To select multiple songs, hold down the Ctrl key (Mac: Command 
key) and click. The selected song will be displayed in focus (highlighted).

Remove a song Select the song, and click the [REMOVE] button.

Rearrange the songs Drag the selected song up or down in the list to move it.
14



It is possible to enter Japanese (multi-byte text) as the song name, but you should use English alphanumeric
characters if you intend to export as an MR project.

Editing text data
You can edit the text data of the current song (the song title and the artist name). When a file is exported, this
information is embedded in the header of the exported file.

Embedding to AAC and the Apple lossless file is not supported.

It is possible to enter Japanese (multi-byte text) as text information, but you should use English alphanumeric
characters if you intend to export in a format other than AIFF, DSF, MP3, WMA, FLAC file or DSD Disc. Due
to limitations in the file format, characters other than English alphanumerics will be ignored when exporting.

1. Double-click a song in the songlist.
That song will become the current song, and the song information will appear in the info viewer.

2. In the info viewer, click the TITLE field to make the song title editable. When you're finished editing, press
the Enter key to finalize the change.

3. In the same way, click the ARTIST field and edit the artist name. 

Click the song name 
that you want to edit

Enter the new song name, 
and press the Enter key 

to finalize the change

Double-click the 
song whose text 

data you want to edit

Click Enter the title and press 
Enter key to finalize
15



If you click the [INFO] tab in the info viewer, you will also be able to edit the “ALBUM” (album name),
“GENRE” (musical style), “LOCATION” (recording location), “REC DATE” (date of recording), and “REC
TIME” (time of recording) information, but depending on the format of the exported file, this information
may not be embedded in the header.

Changing the attached picture
You can attach a picture to the current song. This picture can be embedded when exporting and when creating a
disc.

Loading a picture
AudioGate can load images in the following formats.

·  Image files in JPEG or PNG format

·  Image files embedded in an AIFF, DSF, MP3, WMA, AAC, Apple lossless, or FLAC format audio file

Exporting a picture
AudioGate can embed the picture attached to a file when exporting the following formats.

· AIFF, DSF, MP3, WMA, or FLAC format audio files

· DSD discs

Changing the attached picture

1. In the info view, click the [PICTURE] tab.
The attached picture for the current song will be displayed. If no image is attached, this will show the
AudioGate icon and the message “No picture attached.”

2. Click the attached image or AudioGate icon shown in the tab.
A file selection dialog box will appear.

Click

Click
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3. Select the image file that you want to attach, and click [Open].

You can also change the attached picture by dragging an image file into the [PICTURE] tab.

Simply attaching an image file does not embed the image in the audio file. This means that if you move the
image file, it will no longer be displayed in AudioGate. In order to embed the picture, you must export the
file or create a disc.

Deleting the attached picture

1. In the info view, click the [PICTURE] tab.

2. Move the mouse pointer onto the image shown in the tab, and click the [X] button.

Deleting the attached picture in AudioGate does not delete the original image file.

Editing metadata for multiple songs
You can edit the text information or change the attached picture for the songs selected in the songlist.

1. In the songlist, click a song to select it.

2. Hold down the Ctrl key (Mac: Command key) and click other songs to select multiple songs.

3. From the [Edit] menu, choose [Batch Edit Metadata...].
The metadata editing screen will appear.

4. Click the button at the left of each item you want to edit, so that the desired buttons are selected.

Click
17



5. Edit the data for the items you selected.

Song Name
If [Copy From Title] is selected, the song title will be used as the song name.
If [Insert] is selected, a number will be inserted at the beginning of the song name.
If [Remove] is selected, the number at the beginning of the song name will be deleted.
By clicking the [Separator] field you can edit the text string that is inserted between the number and the song
name.
If you delete the number, the text string you entered in the [Separator] field will also be deleted from the
beginning of the song name.

If the songlist contains songs of the same name, a number will be added to the end of the name; e.g., “Song
name.1”.

Text Information
When you click the text editing field located at the right of an item name, it will become editable. After you've
edited the text, press the Enter key to finalize the change.

Attached Picture
If you want to change the attached image, click the displayed image and then select the desired image file.
If you want to delete the attached image, move the mouse pointer onto the image and click the [X] button.

6. Press the [OK] button.
The metadata editing window will close, and the edits will be reflected in the songlist.

Editing the song settings
Various settings for the selected song are shown at the right of the songlist. You can edit these settings by double-
clicking them and entering a value (or by making the changes by dragging the mouse up or down in the selected
field). These settings are reflected when you play back or export the song.

 Item Method

GAIN Specify the volume level of the song in a range of – 60.0 dB...+ 60.0 dB. Adjust this so that the 
clip indicator does not light during playback or during exporting.

BALANCE This adjusts the left/right volume balance of the song within a range of L100...C...R100. 
However, the balance of a monaural song is fixed at C (center), and cannot be changed.

FADE IN This specifies the shape of the envelope used for the fade-in, and the time duration (0.0 sec-
onds--10.0 seconds) for the fade-in to be completed.

FADE OUT This specifies the shape of the envelope that’s used for fade-out, and the time duration (0.0 
seconds--10.0 seconds) for the fade-out to be completed.

DC CUT Normally you will leave this “OFF” (disabled). If the song file contains a DC offset, you can 
turn this “ON” to remove the offset. While often inaudible, a DC offset can reduce the avail-
able headroom before clipping, and can affect the sound quality in other ways.
18



Dividing a song
You can divide the current song into two separate songs at any point.

1. Use the song playback functions to move to the point where you want to divide the song.

2. Make sure that the playback is paused, and click the [DIVIDE] button.
You will see that the song has been divided in the songlist.

Text data and song settings will generally be carried over into both songs following the Divide operation.

Combining songs
Combining songs splices the end of one song directly to the beginning of another song. Here's how you can com-
bine two or more songs into a single song.

1. In the songlist, click a song to select it.

2. Hold down the Ctrl key (Mac: Command key), and click other songs to select them.

3. Click the [COMBINE] button.
You will see that the songs have been combined in the songlist.

You can use the “Combine” function to join recordings together that were not originally separated by the MR
recorder's automatic split function, but some slight noise may be introduced at the point where the songs are
joined.

Move to the 
dividing point

Click

First half

Last half

Hold down the 
Ctrl key and click

Click

Click

Combined song
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You can't combine songs of differing formats.

You can't combine songs that are in compression formats such as MP3, AAC, Apple lossless (ALAC), or
WMA.

Text data and song settings will generally be taken from the top song in the list.

Channel Link function
This allows you to handle two monaural songs as a single stereo song. Normally you will use this to link two
songs of the same length.

1. Click one of the songs in the songlist to select it.

2. Hold down the [Ctrl] key (Mac: [Command] key) and click the other song so that both songs are selected.

3. Click the [CH LINK] button. Verify that the songs are linked in the songlist.

You can't link songs of differing formats.

You can't link songs that are in compression formats such as MP3, AAC, Apple lossless (ALAC), or WMA.

 If you link songs that are of differing lengths, the resulting length will match the longer song.

Text data and song settings will generally be taken from the upper song in the list.

Mark function

Importing marks
AudioGate can load the following marks.

· Marks included in an MR project

· Marks included in the cue-points chunk of a WAV/BWF file

· Marks (track start and index) included in the marker chunk of a DSDIFF file

Exporting marks
AudioGate can embed marks when exporting the following file formats.

· MR project format

· WAV or BWF files

· DSDIFF files

Editing marks
Click the mark button in the info view window, and the mark editing window will open.

Click
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In the mark editing window you can see mark icons shown above the time slider at mark locations.

Moving to a mark location

Operation Method

Selecting a mark Click the mark icon. The mark icon will be selected, and the mark number 
and mark location will be displayed in the mark box.

Adding a mark Click the [ADD] button to add a mark at the current position.

 You can't add two marks at the same position.

Removing a mark Select the mark that you want to remove, and click the [REMOVE] button.

Editing the location of a mark Select the mark whose location you want to edit, and click the displayed 
mark time. The time indication will become editable. Use the keyboard to 
enter the desired time, and press the Enter key.

Removing all marks from the 
current song

Choose the menu item [Edit]->[Remove All Marks].

Dividing the song at mark 
locations

Choose the menu item [Edit]->[Divide At Marks].

Operation Method

Moving to the next 
mark

Click the “FF” button. You will move to the “next mark” relative to the current posi-
tion.

Moving to the pre-
vious mark

Click the “REW” button. You will move to the “previous mark” relative to the current 
position.

Moving to a speci-
fied mark

Double-click a mark icon.

Click the “▼,” at the right edge of the mark box, and choose a mark from the list.
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Viewing file information
You can view the file paths referenced by a song selected in the songlist.

1. Right-click (Mac: Control-click) a song in the songlist.
A menu will appear.

2. From the menu, choose [File Info...].

A dialog box will appear, showing the file path referenced by the song. If the song was created by combining,
or by using the channel link function, the file path for each time region or channel will be shown.

If the file cannot be found because it has been moved or deleted, the file path is shown in red.

3. Right-click (Mac: Control-click) the file path.

4. If you want to copy the file path to the clipboard, choose [Copy File Path]. If you want to open the folder in
where the file is located, choose [Open Parent Folder].

Other convenient functions

Reverting an edit (Undo)
By choosing the menu command [Edit]-[Undo], you can revert to the state prior to executing the most recent
editing operation.

Re-executing the edit (Redo)
By choosing the menu command [Edit]-[Redo], you can re-execute the operation that was reverted by the
Undo command.
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Exporting in a different audio format
AudioGate can convert the songs in the songlist into a desired format and export them as audio files or use them
to create an audio CD or DSD disc.

The MR series does not necessarily support all formats that are supported by AudioGate. If you want the
exported file to play on your MR series recorder, the file must be converted to a format that your MR series
recorder supports. For more information, please refer to the owner's manual of your MR series unit.

Exporting an audio file
Here's how to convert the songs in the songlist into a desired format and export them as audio files or as an MR
project. The song name in the songlist will be the name of the exported file.

1. Make sure that the songlist contains the file that you want to export, and then click the [EXPORT] button.
The export file setting screen will appear.

2. Set the conversion source. Choose [All Songs] to export all songs in the songlist, or choose [Selected Songs]
to export only selected songs in the list.

Click

Select
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3. In the “Destination” area, click the [...] button and choose the export-destination folder.

4. Specify the desired output file format.

5. Specify the desired output file type.

Mono / Dual Mono
A monaural song will be exported as a monaural file, and a stereo song will be exported as a dual mono file.
This is especially convenient if the file is going to be brought into in a DAW after export.

Click

Select the export-
destination folder

Select

Select
24



Stereo Interleaved:
A channel-interleaved stereo file will be exported. In the case of a monaural song, the L channel and R chan-
nel will contain the same data. If you want to play back the file on the MR series recorder, copy it into the
AUDIO folder.

MR Project:
An MR project folder containing a .prj file and audio file will be exported. This is useful when exporting
very large audio data (exceeding the 4 GB limit of FAT32).
Marks edited by AudioGate can be embedded into the MR project. If you want to play back the songs on the
MR series recorder, copy the file to the appropriate location in the MR_PROJ folder. Please refer to the
owner's manual of your MR series recorder for more information.

6. Specify the desired sample rate and bit depth for the exported file.

You can change the detail settings of the conversion algorithm by click [Edit] button in the option field.
For more information, please refer to "Optional settings" (page 29).

7. Click the [OK] button.
A (red circle) will appear in the upper right of the info viewer, and file conversion export will begin.

During the export process, you can stop the processing by clicking the [EXPORT] button once again.

1-bit audio files may contain louder signals than PCM. When converting 1-bit audio files to PCM files,
you might need to set GAIN settings down by approximately – 3.0 dB to avoid clipping (see page 18).

When exporting a song as a 1-bit audio file, a minimal amount of silence may be added to the end of the
exported file.

Select

Select
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If the input file and the output file have the same sample rates, and if the GAIN and DC CUT settings are
kept to default (see page 18), AudioGate may switch to “direct exporting mode” where unnecessary
recalculation is reduced. The level meter will be fixed to 0dB when AudioGate is running in “direct
exporting mode.”

8. When the process is finished, a dialog box will appear indicating “Export completed”. Click the [OK] but-
ton.

Click

Click
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Creating an audio CD or DSD disc
You can create an audio CD or DSD disc from the songs in the songlist.
Each song in the songlist will be written as one track on the disc.
If the format of a song does not match the format of the disc, the format will be automatically converted before
writing the song to disc.

1. Make sure that the songlist contains the songs that you want to write to disc, and then click the [BURN
DISC] button.
The disc setting dialog box will appear.

2. Specify the songs that you want to burn to disc. If you want all songs in the songlist to be burned to disc,
choose [All Songs]. If you want only the selected song to be burned to disc, choose [Selected songs].

3. Select the format of the disc that you want to burn.

4.  Select the drive you'll use to burn the disc from the list of writable CD/DVD drives.

If you're creating a DSD disc, you must select a drive that can write DVDs.

5. Insert a blank disc or a rewritable disc (CD-RW, DVD-RW, DVD+RW) into the drive that you selected in
step 4.
If any other windows (other applications) are open, close them to exit those applications.

If you're creating an audio CD, you must insert a CD-R or CD-RW disc.

Click

Select
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If you're creating a DSD disc, you must insert a DVD-R, DVD-RW, DVD+R, or DVD+RW disc, whichever
your drive supports.

6. If you inserted a previously-used rewritable disc, click the [Erase] button to make the disc usable.
Choose “Quick Erase” or “Full Erase”.

Quick Erase
The disc's TOC (Table Of Contents) information will be erased to make the disc usable. This allows faster
processing, but in some cases a larger number of errors may occur, depending on the overwrite performance
of the disc. If you experience problems when creating a disc, we recommend that you use Full Erase.

Full Erase (clear the Quick Erase check box)
The disc will be erased completely to make it usable. This will usually take more time than Quick Erase.

 When you erase a disc, all data will be lost. You cannot cancel during this operation, or undo it.

7. Specify the disc writing speed.

If you click [Edit] button in the option field. you'll be able to make detailed settings for the disc and the
conversion algorithm. For more information please refer to “Optional settings.”

8. Click the [Burn] button.
A dialog box will show the progress; format conversion and disc burning will begin.

9. When the disc has been created successfully, the dialog box will indicate “Writing completed. Do you want
to create another disc?”, and the disc will be ejected.

10. If you want to create another identical disc, insert a blank disc and choose [Create].
  If you're finished, choose [Don’t create].
28



Optional settings
When exporting audio files or creating a disc, you can click [Edit] in the option field to make detailed settings for
the disc and conversion algorithm. The items that can be set will depend on the output format.

Album Title
This specifies the album title of the audio CD or DSD disc.
This information is embedded in the disc, and can be displayed by players that support it.

When creating an audio CD, this is written as CD-TEXT.

Use alphanumeric characters if you're creating an audio CD. Some drives may not allow you to specify
this item.

Album Artist
This specifies the name of the album artist for the audio CD or DSD disc.
This information is embedded in the disc, and can be displayed by players that support it.

When creating an audio CD, this is written as CD-TEXT.

Use alphanumeric characters if you're creating an audio CD. Some drives may not allow you to specify
this item.

Go Between Songs
This specifies the spacing between songs on an audio CD. For a drive that supports Disc-At-Once, you can cre-
ate a gapless CD by specifying “None” as the song spacing.

On some drives, the song spacing you specify might not be applied correctly.

When you create a gapless CD, the location of the track division (the point at which songs are divided)
might be automatically adjusted forward by a maximum of 1/75th of a second.

Click
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2.8 MHz DSD Filter
Sets the additional filter for the conversion from 1 bit/2.8 MHz songs to 176.4 kHz or 192 kHz PCM files.

Off
The additional filter will not be applied.

Soft Roll-off (– 3 dB @50 kHz)
 Applies a low-pass filter with soft roll-off.

Sharp Roll-off (– 3 dB @42 kHz)
Applies a low-pass filter with sharp roll-off.

Normalize
This specifies whether normalization (increasing the level as high as possible without creating distortion) will
be applied. If you enable this, the GAIN of each song will be automatically adjusted to the optimal value.

Off
Normalization will not be applied. The volume level after conversion will be according to the original GAIN
setting.

Individual Songs
Each song will be normalized individually to its respective maximum volume. The original GAIN setting
will be completely ignored.

Current Songlist Selections (avg. level)
The maximum peak from all songs being exported will be found, and the songs will be normalized while
preserving the volume balance between songs.

Select

Select
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The original GAIN setting will be used to adjust the balance between songs.

When you use normalization, the automatically-adjusted GAIN will be indicated in blue text while the
files are being exported.

In general, converting the sample rate will require samples to be interpolated, possibly causing the peak
levels to be slightly higher than the original data. If the song's peak level was already close to 0 dB before
normalization, the GAIN may be automatically adjusted to below 0 dB.

1-bit audio data may contain loud sounds that exceed the limits of PCM. If normalization is applied when
converting 1-bit audio to PCM, the GAIN may be automatically adjusted to about -3.0 dB.

When exporting in 1-bit audio format, normalization is applied referenced to 0 dB-SACD, but in some
cases the output data may slightly exceed the reference value (i.e., the level meter indication may exceed 0
dB). Even in this case, the signal is far lower than the theoretical clipping level for 1-bit audio, so there will
be no problem with the exported data as long as the clip indicator does not light.

When normalization has completed successfully, and export or disc creation has ended, a dialog box will ask
“Do you want to load the normalized gain setting to the songlist?” If you choose “Load,” the GAIN setting
used for normalization will be applied to the “Song settings” for each song.

By applying the GAIN used for normalization to the “Song settings” of each song, and then exporting
with the Normalize box set to “Off,” you can greatly reduce the processing time for subsequent exports.
However if you've changed the output sampling frequency, the peak values of the output data will change
slightly, so you'll need to execute normalization once again.

Dither
Here is where you can choose the dither settings for exporting the results of the internal high-precision calcu-
lations as 16/24-bit data.

None
The results of the internal calculations are rounded up or down to 16/24-bit data. If the volume of the song is
sufficiently loud, there will be no particular problems even with this setting.

TPDF Dither
Standard white noise dithering will be applied. The noise floor will increase slightly, but distortion compo-
nents can be completely suppressed.
Choose this if you'll be continuing to edit using another application after exporting the song.

KORG AQUA
This method takes into account the characteristics of human auditory perception, producing a higher-qual-
ity master by limiting the increase of quantization noise in important frequency regions.

Select
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Choose this if you're exporting a song as the final master.

AudioGate is able to automatically detect situations in which dithering is not necessary. Even if dithering
is set to “TPDF Dither” or “KORG AQUA,” this setting may be ignored in some cases to avoid any
increase in noise.

Other settings

Changing the folder where temporary files are created
AudioGate sometimes creates temporary files when creating a disc or importing audio files.
Here's how to change the location where these temporary files are created.

1. From the [Edit] menu, choose [Preferences...] (Mac: [AudioGate]-[Preferences...]).

2. Click the [Others] tab.

3. In “Temporary Folder,” click “...” and select the desired folder.

We recommend that you specify a hard disk drive with plenty of free space as the location in which the tem-
porary file folder is created.

Click
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Resetting the warnings of all dialog boxes
Some warning dialog boxes have an option “Do not show this massage again.” If this check box is selected, that
warning will no longer appear
Here's how to make these suppressed warnings appear again.

1. From the [Edit] menu, choose [Preferences...] (Mac: [AudioGate]-[Preferences...]).

2. Click the [Others] tab.

3. In “Reset All Dialog Warning,” click the [Reset] button.

Regarding the FLAC license
AudioGate uses the FLAC library pursuant to the following license.

Copyright (C) 2000,2001,2002,2003,2004,2005,2006,2007,2008,2009  Josh Coalson
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

 · Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

 · Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

 · Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or pro-
mote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PRO-
CUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Click
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List of shortcuts
Function Windows Mac

New Songlist Ctrl  +  N Command  +  N

Open a Songlist... Ctrl  +  Shift  +  O Command  +  Shift  +  O

Open Last Songlist... Ctrl  +  R Command  +  R 

Save Songlist Ctrl  +  S Command  +  S 

Save Songlist as... Ctrl  +  Shift  +  S Command  +  Shift  +  S

Add Audio Files... Ctrl  +  O Command  +  O

Open Disc... Ctrl  +  Alt  +  O Command  + Option +  O

Open Folder... Alt  +  O Option +  O

Remove Songs Delete Delete

Export... Ctrl  +  Shift  +  E Command  +  Shift  +  E

Burn Disc... Ctrl  +  Shift  +  B Command  +  Shift  +  B

Exit Ctrl  +  Q Command  +  Q

Undo Ctrl  +  Z Command  +  Z

Redo Ctrl  +  Shift  +  Z Command  +  Shift  +  Z

Cut text Ctrl  +  X Command  +  X

Copy text Ctrl  +  C Command  +  C

Paste text Ctrl  +  V Command  +  V

Select All Songs Ctrl  +  A Command  +  A

Select All Marks Ctrl  +  Shift  +  A Command  +  Shift  +  A

Divide Ctrl  +  D Command  +  D

Divide At Mark Ctrl  +  Shift  +  D Command  +  Shift  +  D

Remove All Marks Ctrl  +  Shift  +  Delete Command  +  Shift  +  Delete

Combine Ctrl  +  J Command  +  J

Channel Link Ctrl  +  L Command  +  L

Batch Edit Metadata... Ctrl  +  Shift  +  I Command  +  Shift  +  I

Preference... Ctrl  +  , Command  +  ,

Add Mark M M

Edit Song Name F2 F2

Edit Text Data Ctrl  +  T Command  +  T

Switch Info Viewer Ctrl  +  I Command  +  I

Select song above ↑ ↑

Select song below ↓ ↓

Play selected song Enter Enter

Play/Pause Space Space

Play From... F F
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Play To... T T

Next Mark Ctrl  +  Shift  +  → Command  +  Shift  +  →

Previous Mark Ctrl  +  Shift  +  ← Command  +  Shift  +  ←

Next Song Ctrl  +  → Command  +  →

Previous Song Ctrl  +   ← Command  +  ←

Fast Forward → (Hold down) → (Hold down)

Rewind ← (Hold down) ← (Hold down) 

Move 0.001 second Forward Shift  +  → Shift  +    →

Move 0.001 second Backward Shift  +  ← Shift  +   ←

Move 0.05 second Forward → →

Move 0.05 second Backward ← ←

Move 1 second Forward Alt  +  → Option  +   →

Move 1 second Backward Alt  +  ← Option  +    ←

Direct Locate G G

Function Windows Mac
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